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简介
文件传输协议（File Transfer Protocol，FTP）是 TCP/IP 提供的标准 Internet 协议，用于将文件从一个设备传输到另

一个设备。它是 TCP/IP 协议栈层内的应用层协议。对于任何可联网设备而言，嵌入式 FTP 客户端/服务器是一项有利

补充。FTP 客户端模块将支持应用程序从任何 FTP 服务器上传和下载文件。该协议允许在不同设备之间可靠、高效地

传输数据，而无需担心不同主机的文件存储系统存在差异。

本文档将重点介绍 MPLAB® Harmony v3 TCP/IP 协议栈的 FTP 实现，并使用 SAM E54 单片机进行 FTP 客户端和 FTP
服务器组合演示。FTP 客户端应用程序包含以太网自举程序，用于从 FTP 服务器下载应用程序二进制文件并通过自编

程更新固件。

缩写

• FTP：文件传输协议（File Transfer Protocol）

• HTTP：超文本传输协议（Hypertext Transfer Protocol）

• TCP/IP：传输控制协议/Internet 协议（Transmission Control Protocol/Internet Protocol）

• DHCP：动态主机配置协议（Dynamic Host Configuration Protocol）

• DFP：器件系列包（Device Family Pack）

• MCC：MPLAB 代码配置器（MPLAB Code Configurator）

 利用 MPLAB® Harmony v3 TCP/IP 协议栈在 SAM E54
MCU 上实现文件传输协议
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1. FTP 概述
FTP 基于客户端/服务器模型架构构建，客户端与服务器之间使用单独的控制连接和数据连接。FTP 客户端

在主机与远程 FTP 服务器之间建立连接，通过 TCP 在两台计算机之间提供双向数据传输和文件。客户端通

过指定域、IP 地址、端口、用户名和密码的方式连接到 FTP 服务器，之后即开始工作。完成用户身份验证

后，两个系统之间将建立连接，主机计算机可以将数据上传到 FTP 服务器上。下载 FTP 服务器上的各种文

件和文件夹时可能存在访问限制，具体由 FTP 服务器管理员确定。

FTP 依赖客户端与服务器之间的两种连接：用于控制会话的控制连接和用于发送文件内容的数据连接。当

客户端与服务器之间启动 FTP 会话时，客户端将发起与服务器端的控制 TCP 连接。客户端将通过该连接发

送控制信息。当服务器收到控制信息时，将发起与客户端的数据连接。FTP 会话以主动或被动模式工作，

用于确定如何建立数据连接以及客户端/服务器是否发起传输。有关 FTP 模式和连接的更多信息，请参见

FTP 文档 AN3475。

https://ww1.microchip.com/downloads/en/Appnotes/File-Transfer-Protocol-Using-MPLAB-Harmonyv3-TCPIP-DS00003475A.pdf
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2. 应用概述
本文档使用两个 SAM E54 Xplained Pro 评估工具包演示如何在网络中使用 FTP 服务器和 FTP 客户端，其

中一个评估板用作 FTP 服务器，另一个评估板用作 FTP 客户端。每个 FTP 客户端和 FTP 服务器都有自己的

文件系统介质。IO1 Xpro 板上的 SD 卡用作文件系统的存储介质，供客户端/服务器板用来传输文件。本应

用主要关注 FTP 网络，其中客户端登录到服务器，下载应用程序二进制文件来加载应用程序。

图 2-1. 使用 SAM E54 作为客户端和服务器的模型

Figure 2‐1 SAM E54 as client and server Model

SAM E54 FTP Client

SAM E54 FTP Server

Use for Bootloading
Process

Downloading .bin file

SD card (Filesystem)
IO1 Xpro

SD card (Filesystem)
IO1 Xpro

SPI

SPI

图 2-2. 应用程序和自举程序的存储器

1024KB

0x0000
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3. 硬件和软件要求
本章介绍本应用的软硬件准备工作。

硬件：

• SAM E54 Xplained Pro 评估工具包——2 个

• IO1 Xplained Pro——2 个

• Micro SD 卡——2 个

• 以太网线缆（RJ45）——1 根

• USB 线缆——2 根

软件：

• MPLAB X IDE（v6.00）

• MPLAB XC32 编译器（v4.10）

• MPLAB 代码配置器（v5.1.17）
– Harmony bsp 资源库 v3.13.0（Github bsp）

– Harmony csp 资源库 v3.13.1（Github csp）

– Harmony core 资源库 v3.11.1（Github core）

– Harmony dev_packs 资源库 v3.13.0（Github dev_packs）

– Harmony net 资源库 v3.8.0（Github net）

– Harmony Crypto 资源库 v3.7.6（Github crypto）

https://github.com/Microchip-MPLAB-Harmony/bsp
https://github.com/Microchip-MPLAB-Harmony/csp
https://github.com/Microchip-MPLAB-Harmony/core
https://github.com/Microchip-MPLAB-Harmony/dev_packs
https://github.com/Microchip-MPLAB-Harmony/net
https://github.com/Microchip-MPLAB-Harmony/crypto
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4. MPLAB Harmony v3 中的 FTP
MPLAB Harmony v3 TCP/IP 协议栈库为 FTP 模块的 API 提供了操作便捷的“C”语言界面。该库支持 FTP
服务器和客户端，有助于上传和下载文件。

4.1 TCP/IP 配置器
MPLAB Harmony v3 配置采用易于使用的 GUI——MPLAB 代码配置器（MPLAB Code Configurator，
MCC），可简化器件设置、库选择、配置和应用程序开发。TCP/IP 配置器插件可用于 TCP/IP 配置，方便

用户以图形方式为 MPLAB Harmony v3 项目添加或删除 TCP/IP 功能并根据应用需求配置每个组件。

TCP/IP 配置器插件可从 Project Graph（项目图）窗口中的 Plugins（插件）下拉列表中选择。

图 4-1. TCP/IP 配置器

TCP/IP 配置器窗口的初始化界面包含不同 TCP/IP 层的图形概览。选择每一层可显示可用组件。通过单击

“+”或执行拖放操作从“Available Components”（可用组件）列表中选择应用所需的组件，即可添加

所选组件。随后将弹出一个窗口，用于添加任何与所选组件相关但未满足的项。选择任何已添加的 TCP/IP
组件，在 Project Graph 中的“Configuration Options”（配置选项）中添加配置。

图 4-2. TCP/IP 配置器概览

注：“net”的本地资源库中的“docs”文件夹包含有关配置器的更多信息。

https://www.microchip.com/mplab/mplab-harmony


 AN4833
MPLAB Harmony v3 中的 FTP

 草稿 应用笔记

© 2023 Microchip Technology Inc. 及其子公司

DS00004833A_CN - 7

4.2 FTP 服务器模块
FTP 服务器的功能有利于从嵌入式设备上传和下载文件。FTP TCP/IP 协议栈库的接口在 ftp.h头文件中定

义。若要使用 FTP 服务器，则需在项目中使用 TCP/IP 协议栈和文件系统（本项目中为 FAT FS）。

可以使用 MCC 在 MPLAB Harmony v3 TCP/IP 项目中使能 FTP 服务器：Project Graph > Plugin > TCP/IP
Configuration > Application Layer > Add FTP Server（项目图 > 插件 > TCP/IP 配置 > 应用层 > 添加 FTP 服

务器）。

图 4-3. TCP/IP 配置器中的 FTP 服务器

表 4-1. FTP 服务器模块文件

文件 说明

ftp.h FTP 服务器 TCP/IP 协议栈库的接口

ftp.c FTP 服务器的实现

4.3 FTP 客户端模块
FTP 客户端模块可在不同设备之间可靠、高效地传输数据，而无需担心不同主机的文件存储系统存在差

异。FTP 客户端 TCP/IP 协议栈库的接口在 ftpc.h头文件中定义。

可以使用 MCC 在 MPLAB Harmony v3 TCP/IP 项目中使能 FTP 客户端：Project Graph > Plugin > TCP/IP
Configuration > Application Layer > Add FTP Client（项目图 > 插件 > TCP/IP 配置 > 应用层 > 添加 FTP 客

户端）。
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图 4-4. TCP/IP 配置器中的 FTP 客户端

表 4-2. FTP 客户端模块文件

文件 说明

ftpc.h FTP 客户端 TCP/IP 协议栈库的接口

ftpc.c FTP 客户端协议的实现

下表列出了 FTPC 模块支持的 FTP 命令。

表 4-3. FTPC 模块支持的 FTP 命令

FTP命令 协议栈命令类型 函数名称

USER：发送用户名 TCPIP_FTPC_CMD_USER TCPIP_FTPC_Login
PASS：发送密码 TCPIP_FTPC_CMD_PASS TCPIP_FTPC_Login
ACCT：发送帐户信息 TCPIP_FTPC_CMD_ACCT TCPIP_FTPC_Login
TYPE：设置传输类型 TCPIP_FTPC_CMD_TYPE TCPIP_FTPC_SetType
STRU：设置文件传输结构 TCPIP_FTPC_CMD_STRU TCPIP_FTPC_SetStruct
MODE：设置传输模式 TCPIP_FTPC_CMD_MODE TCPIP_FTPC_SetMode
PASV：进入被动模式 TCPIP_FTPC_CMD_PASV TCPIP_FTPC_SetPassiveMode
PORT：打开数据端口 TCPIP_FTPC_CMD_PORT TCPIP_FTPC_Connect
RETR：获取远程文件 TCPIP_FTPC_CMD_GET TCPIP_FTPC_GetFile
STOR：将文件存储到远程主机上 TCPIP_FTPC_CMD_PUT TCPIP_FTPC_PutFile
NLST：远程目录的名称列表 TCPIP_FTPC_CMD_NLST TCPIP_FTPC_NameList
LIST：列出远程文件 TCPIP_FTPC_CMD_LIST TCPIP_FTPC_List
DELE：删除远程文件 TCPIP_FTPC_CMD_DELE TCPIP_FTPC_DeleteFile
CWD：更改工作目录 TCPIP_FTPC_CMD_CWD TCPIP_FTPC_Change_Dir
CDUP：CWD 指向当前目录的父目录 TCPIP_FTPC_CMD_CDUP TCPIP_FTPC_ChangeToParentDir
MKD：创建远程目录 TCPIP_FTPC_CMD_MKD TCPIP_FTPC_MakeDir
RMD：删除远程目录 TCPIP_FTPC_CMD_RMD TCPIP_FTPC_RemoveDir
PWD：打印工作目录 TCPIP_FTPC_CMD_PWD TCPIP_FTPC_Get_WorkingDir
QUIT：终止连接 N/A TCPIP_FTPC_Logout

除了实现 FTP 命令外，客户端模块还通过 USART 终端提供用户界面。这样，用户便可通过进入终端来提

供所需的 FTP 命令。所有 FTP 客户端命令均以关键字“ftpc”开头，例如 ftpc login <username>
<pswd>。
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5. FTP 客户端和服务器：应用程序实现
本章介绍创建应用程序之前的准备工作。

5.1 MPLAB Harmony v3 配置
• 要使用 MPLAB X IDE 为 SAME54P20A 创建 32 位 MPLAB Harmony v3 项目，请访问 https://

microchipdeveloper.com/harmony3:same54-getting-started-training-module。

• 启动配置时，默认将显示器件系列包（Device Family Pack，DFP）、系统、CMSIS 包、NVMCTRL 和

EVSYS。

• 添加 SD 卡（SPI）驱动程序，为 IO1 Xplained Pro 板上的 SD 卡提供接口。

• 系统服务（包括控制台、命令、调试、时间、文件系统和 TCP/IP 功能）必须与所需的满足条件一起添

加，如下所示。

图 5-1. FTP 客户端/服务器项目图

5.2 TCP/IP MPLAB Harmony v3 配置
要为客户端和服务器配置 TCP/IP 基本配置器，请按以下步骤操作：

1. TCP/IP 配置器将打开 TCP/IP 配置器部分所述的窗口。添加选定内容后，可通过 TCP/IP 配置器或

Project Graph 查看相关视图。可以通过 Project Graph 选择不同的视图，如下图所示：

图 5-2. 选择视图

2. 在基本配置视图中，使能 TCPIP CMD 和 TCPIP CORE 组件。

https://microchipdeveloper.com/harmony3:same54-getting-started-training-module
https://microchipdeveloper.com/harmony3:same54-getting-started-training-module
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图 5-3. 基本配置器

注：在 TCP/IP CORE 配置选项中，可以根据应用要求调整 TCP/IP Stack Dynamic RAM Size（TCP/IP
协议栈动态 RAM 大小）。

3. 在数据链路配置选项中，网络接口配置为必要 PHY 连接。确保为客户端和服务器配置所需的网络详细

信息，例如 IP 地址和网关地址。内部以太网驱动程序（GMAC）与 KSZ8091 PHY 驱动程序一起使能来

完成 SAME54 演示。SAME54 Xplained Pro 评估工具包上配有 KSZ8091。MIIM 驱动程序支持异步读/
写和扫描操作，用于访问外部 PHY 寄存器以及在 MIIM 操作完成时发出通知。

图 5-4. 数据链路配置
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图 5-5. NETCONFIG 选项

注：网络组件的这种配置可通过单击项目图上的组件或单击 TCP/IP 配置插件中的组件来完成。这也适用于

MPLAB 代码配置器图形用户界面（Graphical User Interface，GUI）的其他 TCP/IP 网络组件。

5.2.1 FTP 服务器配置

TCP/IP 应用层配置

按照以下步骤配置 TCP/IP 应用层：

• 在 TCP/IP Configuration（TCP/IP 配置）窗口中的 TCP/IP Layers（TCP/IP 层）下，单击

“Application”（应用）。

• 在应用层视图中，TCP/IP 应用层配置器支持以下组件：ANNOUNCE、FTP SERVER、DHCP Server、
SNTP 和 DNS CLIENT。

• ANNOUNCE 模块有助于在支持 DHCP 的网络上发现设备，而 DHCP CLIENT 模块允许应用程序从网络

上的 DHCP 服务器动态获取 IP 地址。

注：对于 FTP 服务器项目，添加 FTP 服务器组件即可满足需求；而对于使用 DNS 的 FTP 客户端项目，

添加 FTP 客户端组件即可满足需求。上述这些是附加网络协议。
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图 5-6. FTP 服务器应用层配置

• FTP 服务器使用 FAT FS 来访问 SDCARD 介质中的文件。在 FTP SERVER 配置中，按下图所示配置 FTP
服务器根目录路径：

图 5-7. FTP 服务器配置

5.2.2 FTP 客户端配置

TCP/IP 应用层配置

按照以下步骤配置 TCP/IP 应用层：

• 对于客户端，在 TCP/IP 应用层配置器中，使能 ANNOUNCE、FTP CLIENT 和 DHCP CLIENT 组件：
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图 5-8. FTP 客户端应用层配置器视图

• 在 FTP CLIENT 配置中，Enable Console Commands（使能控制台命令）选项允许用户通过串行终端

与 FTP 客户端进行交互。可以根据需要增大发送和接收缓冲区的大小（最高 1,024 字节）。

图 5-9. FTP 客户端配置

5.3 运行应用程序

5.3.1 硬件设置
按照以下步骤设置硬件：

1. 将 IO1 Xpro 板连接到 SAME54 Xplained Pro 评估工具包的 EXT1。

2. 将 Micro SD 卡插入 IO1 Xpro 板背面的 Micro SD 卡插槽。确保 FTP 服务器中的 SD 卡包含 FTP 客户端

要下载的二进制文件（test.bin）。

3. 将 micro-USB 线缆从计算机连接到 SAM E54 Xplained Pro 评估工具包上的 DEBUG USB 连接器。

4. 通过 RJ45 线缆连接两个 SAM E54 Xplained Pro 评估工具包的 RJ45 端口，如下图所示：
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图 5-10. SAM E54 客户端/服务器连接

5.3.2 对 MCU 进行编程

按照以下步骤对 MCU 进行编程：

1. 下载 FTP 客户端和 FTP 服务器项目（随本文档一起提供，用户也可以从链接 FTP 客户端和 FTP 服务器

下载）。

2. 在 MPLAB X IDE 中打开项目（File > Open Project（文件 > 打开项目），然后浏览到
same54_ftp_client\firmware\ftp_client_sam_e54_xpro.X和

same54_ftp_server\firmware\ftp_server_sam_e54_xpro.X）。

3. 通过单击 （make and program device（编译并编程器件）图标）编译项目并将其编程到两个目标

板上，一个 SAM E54 Xplained Pro 评估工具包板上为客户端项目

（ftp_client_sam_e54_xpro），另一个 SAM E54 Xplained Pro 评估工具包板上为服务器项目

（ftp_server_sam_e54_xpro）。

5.3.3 连接 FTP 服务器

按照以下步骤连接 FTP 服务器：

1. 通过调试 USB 端口为 FTP 服务器板上电。

2. 刷写 SAM E54 Xplained Pro 评估工具包 FTP 服务器板中的 FTP 服务器项目并打开终端（Tera Term）

same54_ftp_server\firmware\ftp_server_sam_e54_xpro.X。

3. 刷写后，FTP 服务器将完成初始化，控制台将打印服务器 IP 地址，如下图所示。

https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/latest/download/same54_ftp_client.zip
https://github.com/Microchip-MPLAB-Harmony/reference_apps/releases/latest/download/same54_ftp_server.zip
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图 5-11. FTP 服务器控制台输出

注：连接到 SAM E54 FTP 客户端项目（以太网自举程序）之前，将应用程序二进制文件

（same54_ftp_client/utilities/test.bin）复制到 FTP 服务器板的 IO1 Xpro 扩展中的

MicroSD 卡。客户端将下载该二进制文件来执行自举。

5.3.4 连接 FTP 客户端

FTP 客户端的用户应用程序必须发起 FTP 连接请求。根据服务器对请求的响应，客户端必须提供用户名和

密码才能登录。FTP 客户端成功登录后，即可在服务器和客户端之间传输数据。（应用程序可以使用用户

自己的客户端/服务器，例如 Windows®客户端、嵌入式服务器/嵌入式客户端或 Linux®服务器等）。

在该应用程序中，客户端从服务器下载二进制文件，该文件将存储到客户端板的 IO1 Xpro 上的 SD 卡上，

随后编程到单片机中。
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图 5-12. FTP 客户端中的 FTP 自举程序的流程图
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按照以下步骤连接到 FTP 客户端：

1. 通过串行终端窗口应用程序（Tera Term）连接到 SAM E54 Xplained Pro 评估工具包枚举的 COM 端

口。

2. 重启应用程序（复位 SAM E54 Xplained Pro 评估工具包）。

3. IP 地址将显示在终端上，如下图所示。
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图 5-13. FTP 客户端初始化

4. 用户随后可通过输入 ftpc connect <server ip address>连接到 FTP 服务器。

5. 成功连接后，输入以下登录详细信息：ftpc login <username> <password>。
6. 登录后，使用以下 ftpc获取从服务器下载二进制文件的命令：

ftpc get -a -a <test.bin>。消息“Command Success”（命令成功）表示二进制文件已成功

下载。

7. 接收到“Command Success”消息后，请输入命令“boot”。“boot”是为使下载的二进制文件开

始自举而定义的命令。

8. 完成编程后，MCU 会复位，并且应用程序代码开始执行。

注：

• 必须使用二进制文件进行下载和自举。

• 源代码包含使 LED 闪烁的 same54_ftp_client/utilities/test.bin。该二进制文件必须保存到

编程了 SAME54 FTP 服务器项目的 SAM E54 Xplained Pro 评估工具包的 SD 卡中。
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图 5-14. 输出
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6. 附录

6.1 生成应用程序二进制文件（测试应用程序配置）
通常，嵌入式固件在闪存的基址处编程自举程序。在闪存中，自举程序代码后面是应用程序映像。要在

MPLAB X IDE 中生成应用程序项目的二进制文件，应执行下面几节所示的步骤。

6.1.1 禁用 Generate Fuse Settings（生成熔丝设置）

通常，SAM MCU 的熔丝配置设置通过编程工具进行编程。由于应用程序通过自举程序进行编程，因此测

试应用程序中禁用了熔丝设置。使能熔丝设置会增加二进制文件的大小。

6.1.2 修改 Application Start Address (Hex)（应用程序起始地址（十六进制））

应用程序起始地址值必须等于或大于闪存基址 + 自举程序大小。该值必须与生成期间提供给自举程序代码

的值匹配。器件复位时，自举程序将使用应用程序起始地址值跳转到应用程序。

熔丝设置和应用程序起始地址可使用 MCC 修改。启动 MCC 并配置“System”（系统）组件，如下图所

示。

图 6-1. MCC 中的系统设置配置

要更改应用程序的起始地址，应导航到 Project Properties > xc32-ld > Option categories: Symbols & Macros
（项目属性 > xc32-ld > 选项类别：符号和宏）。用户需要定义 ROM_ORIGIN和 ROM_LENGTH宏。
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图 6-2. 项目属性

6.1.3 在 MPLAB X IDE 中生成二进制文件

要生成二进制文件，应按照下列步骤操作：

1. 转到 Project Properties > Building（项目属性 > 编译）。

2. 选择 Execute this line after build（在编译之后执行该行）选项，然后插入以下命令：

${MP_CC_DIR}\xc32-objcopy -I ihex -O binary "${DISTDIR}/${PROJECTNAME}.${IMAGE_TYPE}.hex" 
"${DISTDIR}/${PROJECTNAME}.${IMAGE_TYPE}.bin"
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图 6-3. Bin 文件生成

编译项目后。bin 文件的输出位于以下路径：<your_project>.X\dist\<config_name>\production\。

6.2 所下载二进制文件的自编程
用户可以使用本文档中演示的 FTP 客户端应用程序从任何 FTP 服务器（可以使用任何 FTP 服务器）下载所

需的应用程序二进制文件。二进制文件下载到客户端文件系统后，即可编程到 MCU 的闪存中，如下面的

流程图所示。有关擦除和编程闪存扇区的实现，请参见本应用程序的源代码

（same54_ftp_client\firmware\src\app.c）中的 APP_Flash_Task()函数。
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图 6-4. 编程二进制文件
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6.3 进入应用程序代码
每次复位后，自举程序代码都会检查以下内容：

• 用户按钮（SW0）是否按下

• 分配给应用程序的闪存地址中的应用程序代码是否有效

如果满足以上任一条件，则执行将跳转到用户应用程序代码，而不执行 FTP 客户端自举程序。

注：有关更多信息，请参见文档 AN3475。

https://ww1.microchip.com/downloads/en/Appnotes/File-Transfer-Protocol-Using-MPLAB-Harmonyv3-TCPIP-DS00003475A.pdf
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7. 参考资料
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microchip-mplab-harmony.github.io/net/frames.html?frmname=topic&frmfile=index.html
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datatracker.ietf.org/doc/html/rfc959
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• MPLAB Harmony GitHub wiki：
github.com/Microchip-MPLAB-Harmony/Microchip-MPLAB-Harmony.github.io/wiki
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– 用于 MPLAB® Harmony v3 项目的 MCC 内容管理器

• MPLAB®代码配置器概述与 MPLAB Harmony 内容：

microchipdeveloper.com/harmony3:mcc-overview
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Microchip 信息

Microchip 网站
Microchip 网站（www.microchip.com）为客户提供在线支持。客户可通过该网站方便地获取文件和信

息。我们的网站提供以下内容：

• 产品支持——数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以及硬件支持文档、最新
的软件版本以及归档软件

• 一般技术支持——常见问题解答（FAQ）、技术支持请求、在线讨论组以及 Microchip 设计伙伴计划成

员名单

• Microchip 业务——产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活动安排表、Microchip
销售办事处、代理商以及工厂代表列表

产品变更通知服务
Microchip 的产品变更通知服务有助于客户了解 Microchip 产品的最新信息。注册客户可在他们感兴趣的

某个产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收到电子邮件通知。

欲注册，请访问 www.microchip.com/pcn，然后按照注册说明进行操作。

客户支持
Microchip 产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（ESE）

• 技术支持

客户应联系其代理商、代表或 ESE 寻求支持。当地销售办事处也可为客户提供帮助。本文档后附有销售办

事处的联系方式。

也可通过 www.microchip.com/support 获得网上技术支持。

Microchip 器件代码保护功能
请注意以下有关 Microchip 产品代码保护功能的要点：

• Microchip 的产品均达到 Microchip 数据手册中所述的技术规范。

• Microchip 确信：在正常使用且符合工作规范的情况下，Microchip 系列产品非常安全。

• Microchip 注重并积极保护其知识产权。严禁任何试图破坏 Microchip 产品代码保护功能的行为，这种

行为可能会违反《数字千年版权法案》（Digital Millennium Copyright Act）。

• Microchip 或任何其他半导体厂商均无法保证其代码的安全性。代码保护并不意味着我们保证产品是

“牢不可破”的。代码保护功能处于持续发展中。Microchip 承诺将不断改进产品的代码保护功能。

法律声明
提供本文档的中文版本仅为了便于理解。请勿忽视文档中包含的英文部分，因为其中提供了有关

Microchip 产品性能和使用情况的有用信息。Microchip Technology Inc.及其分公司和相关公司、各级主

管与员工及事务代理机构对译文中可能存在的任何差错不承担任何责任。建议参考 Microchip Technology
Inc.的英文原版文档。

本出版物及其提供的信息仅适用于 Microchip 产品，包括设计、测试以及将 Microchip 产品集成到您的应

用中。以其他任何方式使用这些信息都将被视为违反条款。本出版物中的器件应用信息仅为您提供便利，

将来可能会发生更新。如需额外的支持，请联系当地的 Microchip 销售办事处，或访问 https://
www.microchip.com/en-us/support/design-help/client-supportservices。

https://www.microchip.com
https://www.microchip.com/pcn
https://www.microchip.com/support
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Microchip“按原样”提供这些信息。Microchip 对这些信息不作任何明示或暗示、书面或口头、法定或其

他形式的声明或担保，包括但不限于针对非侵权性、适销性和特定用途的适用性的暗示担保，或针对其使

用情况、质量或性能的担保。

在任何情况下，对于因这些信息或使用这些信息而产生的任何间接的、特殊的、惩罚性的、偶然的或间接

的损失、损害或任何类型的开销，Microchip 概不承担任何责任，即使 Microchip 已被告知可能发生损害

或损害可以预见。在法律允许的最大范围内，对于因这些信息或使用这些信息而产生的所有索赔，

Microchip 在任何情况下所承担的全部责任均不超出您为获得这些信息向 Microchip 直接支付的金额（如

有）。如果将 Microchip 器件用于生命维持和/或生命安全应用，一切风险由买方自负。买方同意在由此引

发任何一切损害、索赔、诉讼或费用时，会维护和保障 Microchip 免于承担法律责任。除非另外声明，在

Microchip 知识产权保护下，不得暗中或以其他方式转让任何许可证。
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质量管理体系
有关 Microchip 的质量管理体系的信息，请访问 www.microchip.com/quality。

https://www.microchip.com/quality
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中国 - 东莞

电话：86-769-8702-9880
中国 - 广州

电话：86-20-8755-8029
中国 - 杭州

电话：86-571-8792-8115
中国 - 香港特别行政区

电话：852-2943-5100
中国 - 南京

电话：86-25-8473-2460
中国 - 青岛

电话：86-532-8502-7355
中国 - 上海

电话：86-21-3326-8000
中国 - 沈阳

电话：86-24-2334-2829
中国 - 深圳

电话：86-755-8864-2200
中国 - 苏州

电话：86-186-6233-1526
中国 - 武汉

电话：86-27-5980-5300
中国 - 西安

电话：86-29-8833-7252
中国 - 厦门

电话：86-592-2388138
中国 - 珠海

电话：86-756-3210040

印度 - 班加罗尔

电话：91-80-3090-4444
印度 - 新德里

电话：91-11-4160-8631
印度 - 浦那

电话：91-20-4121-0141
日本 - 大阪

电话：81-6-6152-7160
日本 - 东京

电话：81-3-6880-3770
韩国 - 大邱

电话：82-53-744-4301
韩国 - 首尔

电话：82-2-554-7200
马来西亚 - 吉隆坡

电话：60-3-7651-7906
马来西亚 - 槟榔屿

电话：60-4-227-8870
菲律宾 - 马尼拉

电话：63-2-634-9065
新加坡

电话：65-6334-8870
台湾地区 - 新竹

电话：886-3-577-8366
台湾地区 - 高雄

电话：886-7-213-7830
台湾地区 - 台北

电话：886-2-2508-8600
泰国 - 曼谷

电话：66-2-694-1351
越南 - 胡志明市

电话：84-28-5448-2100

奥地利 - 韦尔斯

电话：43-7242-2244-39
传真：43-7242-2244-393
丹麦 - 哥本哈根

电话：45-4485-5910
传真：45-4485-2829
芬兰 - 埃斯波

电话：358-9-4520-820
法国 - 巴黎

电话：33-1-69-53-63-20
传真：33-1-69-30-90-79
德国 - 加兴

电话：49-8931-9700
德国 - 哈恩

电话：49-2129-3766400
德国 - 海尔布隆

电话：49-7131-72400
德国 - 卡尔斯鲁厄

电话：49-721-625370
德国 - 慕尼黑

电话：49-89-627-144-0
传真：49-89-627-144-44
德国 - 罗森海姆

电话：49-8031-354-560
以色列 - 若那那市

电话：972-9-744-7705
意大利 - 米兰

电话：39-0331-742611
传真：39-0331-466781
意大利 - 帕多瓦

电话：39-049-7625286
荷兰 - 德卢内市

电话：31-416-690399
传真：31-416-690340
挪威 - 特隆赫姆

电话：47-72884388
波兰 - 华沙

电话：48-22-3325737
罗马尼亚 - 布加勒斯特

电话：40-21-407-87-50
西班牙 - 马德里

电话：34-91-708-08-90
传真：34-91-708-08-91
瑞典 - 哥德堡

电话：46-31-704-60-40
瑞典 - 斯德哥尔摩

电话：46-8-5090-4654
英国 - 沃金厄姆

电话：44-118-921-5800
传真：44-118-921-5820

https://www.microchip.com/support
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